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TIPS are shown in Gray. For example, CleverCat remembers the last Database you used, so you 
don’t have to select it each time, just click the Data Editor button. 

CleverCat Online 

 

 

 

The Main Menu 

The Main Menu is the application’s switchboard. From here, select which database you want to work 
with by clicking its name in the list. The Data Editor is the most common starting point as most of the 
application’s features can be accessed from there. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Read Me First 
This manual is written in a special way. Step-by-step instructions are provided in the Green boxes, 
like this one. You can read the rest of the information on the page if you like, but you only need to 
follow along with these steps to produce a basic catalog. 

Select Sample_Data, then click the Data Editor Button. 
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The Data Editor is similar to an Excel Workbook, with products organized into  
Categories instead of Worksheets. Click any category in the Category Window to 

display its products in the Datasheet. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Editing Data in the Datasheet 

The Datasheet is the online equivalent of an Excel Spreadsheet. Edit any cell by double-clicking it, or 
copy-and-paste data between cells or to and from a spreadsheet on your local computer. There are 
several different Text Editors that may open when you edit a cell, depending on its Type.  

 

 

 

 

 

 

 

Click the Cheese Category to view its products in the Datasheet.  

Double-click the Description cell to open the Multi-Line Text Editor. Click anywhere outside the cell 
to close the Text Editor and save your changes. 
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Column Names do 
not have to match. 

Adding Data to the Datasheet 

There are three methods for adding data. The first, and simplest, is to type it into the cell. Before you 
can do that, you’ll need to create some blank rows. Use the Insert function in the Datasheet Header. 

You can insert Rows at the Top 
or Bottom of the Datasheet, or 
select any position in the middle 
using the Rows at Selector. 

 

 

 

 

 

 

Double-click any cell to enter new 
data. 
 

While manual-entry is the 
simplest, there’s a faster method 
if you already have a spreadsheet 
with your product listings. 

To copy-and-paste data, change 
the Block Mode to Cells. 
 

 

 

You can copy any number of cells from a Spreadsheet on your computer into the online Datasheet, but 
you’ll first want to organize the columns so they match up with those in the Datasheet. 

 

 

 

 

 

 

 

Click a row in the Datasheet.  

Set the Position Selector to 
Selected. 

Type 4 in the Quantity Box. 

Click the Insert button.  

Set Block Mode to Cells. Open a Spreadsheet with matching columns.  

Select a block of cells 
in the Spreadsheet. 
Press Ctrl+C to copy 
them to the 
Clipboard.  
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IMPORTANT: Note that only two Rows were highlighted in the Datasheet, but four were pasted. This 
method will always paste the entire Clipboard, and could result in data loss if there are not enough 
blank rows. 

The same copy-and-paste method can be used within the Datasheet, or to copy Rows from the 
Datasheet to a Spreadsheet on your local computer. 

This method has been tested with thousands of rows in different browsers, but your results could vary 
depending on your Operating System, Browser, and Internet Connection. Expect the process to take 10 
to 20 seconds for every hundred rows. Your browser may appear to be frozen while the transfer is in 
progress. Do not close the browser until all rows have been copied. 

 

At this stage, you’ll want to add photos. If the names of the photos were included in the data you pasted 
into the Datasheet, then all you need to do is upload the files and they’ll be automatically linked. If not, 
there is a manual method in the Photo Selection Tool. 

 

Drag your mouse over a block of cells in the Datasheet to highlight them in Yellow. Press Ctrl+V.  

IMPORTANT: This method will not work for data which contains carriage returns. Use the Import 
Data from a CSV method if your text contains multiple lines within a cell.  
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If you know the name of the file, you can type that instead and click the Select button.    
Change the size of the Selection Grid on the Configuration form off the Main Menu. 

The Photo Selection Tool is also where you’ll upload image files to CleverCat’s server. You can upload 
hundreds of files at once. Thumbnails will be created automatically and added to the grid. 

 

 

 

There are 
Filters and 
Pages to make 
it easier to find 
photos. 

 

  

Double-click any Photo Cell in the Datasheet to open the Photo Selection Tool. 

Double-click any Thumbnail in the Selection Grid to assign that photo to the current Datasheet cell. 

Click Add Files to open a Browsing Window where you can select files to upload. 
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Import Data from a CSV File 

 

 

The final method of adding data requires more setup but is the best option when there are thousands of 
records, or if the data contains carriage returns. This method only works with a CSV file.  

 

 

 

 

 

 

 

 

With Excel, choose Save As from the File Menu, and select CSV (Comma delimited) as the Type.  

The procedure for Uploading and Importing a CSV file is divided into four steps. 

 

 

  

 

 

 

 
 
Most users will not have 
to use the Fields Options 
under Step 2. The CSV File 
should appear in the  
Temporary Datasheet. 
 
 
 
Expect the Import process 
to take about 10 seconds 
for every 1,000 rows. 
 

Return to the Main Menu and click the Import Data Button. 

Step 1 - Click the Blue and White Upload Icon to select a CSV file on your local computer. 

Step 2 - Click the 
name of the 
uploaded file, then 
click Import. 



7 

If your CSV file shows up in the Temporary Datasheet, continue to Step 3 on the Mapping Tab. 

 

Mapping is the process of selecting which 
Columns to import from the Spreadsheet 
(Temporary Datasheet) to the Product  
Database. 

 
 
 
 

The only required selection is Category in 
First Stack, which is for pre-defined cells. 
The other Stacks are for your custom data. 

NOTE: The names in your Spreadsheet 
do not have to match the Custom Labels. 

 
 
 
 
 

Change the Labels as required. 
 
 
The columns you select for the Map do not have to be in the same order as they appear in the 
spreadsheet, and importing them does not mean they have to be printed. For example, many users 
import a column which contains the Cost of the products, but never print that data.  
 
After creating the Map, you’re ready to copy the data from the Temporary Datasheet to your Product 
Database. There are options for using a CSV file later to update your data, but for the first time, use the 
Append function.  
 
 

 
 
 

 
 
 
This process will take approximately 10 seconds for every 1,000 rows, and will report the number of 
Records imported and Categories created. 
 
If the imported data includes the names of the Image Files, they will be automatically linked when those 
files are uploaded. 
 
The next step is to create a Template. 

Select all the optional columns you 
want imported from the Spreadsheet. 

Step 3 – Select the Column from your 
Spreadsheet that contains the Category. 

Step 4 - Append. 
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Create a Printing Template 

 

 

When you create a new Category, either by importing or using the New button in the Category Window 
Header, a default Template will be assigned. However, you’ll want to create your own Custom Template. 
 

 

 

 

If your Custom Template already 
exists, click Template Editor on 
the Navigation Bar instead. 

 

The Page Setup Form 

The Template Designer is made up of several different forms. The first is Page Setup, where you define 
the general appearance of the page—number of Product Layouts, Headers, Footers, and so on. 

 

 

  

Return to the Main Menu and click Data Editor. 

Click Create New Template, 
and enter a name when 
prompted. 

Change Columns and Rows to alter the arrangement of Product Layouts on the Design Pad. 
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Headers and Footers 

The Page Header can include the Category Name, 
Subcategory, Company Banner or Category Banner. 

The Page Footer can include Footer Text, Page 
Numbers, Category Name, Subcategory, or Date. 
 

The next step is to design the Product Layout, 
which applies to all products in the category. 

 

 

 
 
Product Layout 
 
Active Cell indicates which cell you are working with. Click any Cell or Placeholder to make it Active. 

 

 
 
 
 
 
 
 
 

 
 
 

 

 

 

 

Labels are on the left, Data Cells on the right. 

Choose a Header Option that includes a 
Company Banner, which will be added 
later in this tutorial. 

Click Product Layout 
on the Navigation Bar. 

Add a Cell to the Design Pad 
by double-clicking its 
Placeholder in the  
Stacks. 

Drag the 
Anchors at 
the corners 
of the Cell 
to resize it. 

Click 
Return to 
Stack to 
remove the 
Active Cell. 
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TIP: Put a Border around the cells to make it easier to size and place them. 

 

 

 

 

 

 

 

 

 

 

 

Click All Fields or All Labels, then change the Border Width. 

 

 

 

 

 

 

 

 

 

 

 

 

 
The cell borders allow us to see at a glance that 
some cells must be resized. 

Product is too narrow, forcing text to a second line. 

Description is too short, cutting off the text. 

Click any Cell on the Design Pad and use the controls on the Format tab to style the text. 

Click PDF to open a Preview in a new browser tab. 
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NOTE: When printing from a Design-related 
page, only one full page plus one item on the 
second page will be printed. To print an entire 
category, print from the Data Editor or 
Printing Menu. 

Resize cells as required. In this example, changing the heights of the cells to just what is required for the 
text, creates much more space for the photo, which has been made much larger. 

 

 

 

 

 

 

 

 
Remember to remove the Cell Borders: Click 
All Fields, then set the Width to 0. 

Continue resizing and formatting cells until the 
Desired look has been achieved. 

 

 

 
 
 
 
 
Photos automatically fill the available space. In this example, the photo on the left closely matches the 
shape of the space created for it, and nearly fills the rectangle. The one on the right is tall and narrow, 
and is constrained by it’s height, leaving much white space on the sides. 
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Earlier, you selected a Header Option that included Company Banner, which prints in the Page Header 
of every category. This is different from a Category Banner, which can be different for each category.  

 

 

NOTE: You can choose a 
different image for the Right 
Page, to create the effect of a 
banner that spans both pages of 
a center-bound book. If you 
leave this option blank, the 
image you select for the Left 
Page will be printed on both. 

 

In this example, the Banner is 
printing on the left side of the 
Header, but if you print in 
Duplex mode, the Banner and 
Category Label can switch sides 
so that one is always on the 
outside or inside of a center-
bound book. 

 

 

 

 

 

You can create as many PDF catalogs as 
you like, but your account comes with one 
free Hosted document on CleverCat’s server. 

Choose a name that’s easy for your customers 
to remember, and you can Publish a catalog 
on the Printing Menu. For example, enter 
“myCompany”, and your document will be 
hosted at: www.clevercatalogs.com/myCompany 
 

 

Return to the Main Menu and click Config to select a Company Logo image. 

Under the General tab, click the Select button to upload an image file. 

Enter a name in the Public Document field 
on the PDF tab. 

Click Print to continue. 



13 

Printing a Catalog 

The Category List shows all your product categories, along with the Template assigned to them. Change 
the Template by double-clicking its name to open the drop-down selector. 

 

Use the Checkboxes to set 
which categories will be 
included in your PDF 
document. 

 
 
 
 
 

PDF Documents created using the Print button are queued and eventually appear on the Files tab. It 
typically takes less than 10 seconds to create a file, but larger files may take longer. 
 

 

 

 

 

 

 

The documents you create are in a private Folder 
that cannot be accessed without logging in to 
the application. If you entered a Public Document 
name on the Configuration page, you can Publish 
one of your catalogs to a public folder using a 
shortened link.  The link will never change, 
regardless of which file you Publish.  
 
After clicking Publish, the Public Link will be 
displayed. Click it to open the catalog, or copy 
the link to share with your customers. 

Click Preview highlighted to create a PDF of the currently highlighted category in a new browser tab 

Click Print selected to create a PDF of all selected categories. Enter a name when prompted. 

Click Update on the Files tab to see if your document has finished printing. 

Click to select a file in your list and click the 
Publish button to host your catalog for free. 
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Page Numbers (Index) and Page Count may not be correct until after you have printed your catalog for 
the first time. Check Rebuild Page Index on the Options tab before printing. 

 
 
 

 

 

 

 

 
To change the printing order of your columns, simply drag-and-drop any row to a 
new position, then click the click the Renumber Index button on the Navigation Bar. 

 

 

Similar to the checkboxes that select 
which category to print, there are  
Checkboxes in the Datasheet to select 
the rows that will be included in the 
Category. 
 
Return to the Data Editor to make 
those selections. 
 

 

That’s all you need to know to create a basic catalog. The application has many more features: Data 
Tables, Barcodes, Filters, Copying, Sorting, Searching, Customized Data-entry Form, Duplexing, 
Flipbooks, Labels, Table of Contents, Index Page, and more.  

 

The last, and possibly most important thing you need to know, is that we can assist you with almost any 
aspect of creating your catalog. With your permission, we can login to your account and create 
templates for you, or provide remote-desktop training where we work together, sharing control of 
mouse and keyboard, to guide you through the application. 

 


